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This manual applies to ChemStation Software (version B.04.02 SP1 and
later until superseded) and Agilent 6100 Series LC/MS instruments.

Where to find more information

Online Help Use online Help for in-depth information beyond what is
shown in this Quick Start Guide. Display online Help in any of the
following ways:

¢ (Click the Help button in the toolbar.
¢ Select Help Topics from the Help menu.
¢ (Click the Help button on most dialog boxes to show task-specific help.
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User Guides Besides this Quick Start Guide, the following guides are
shipped with your system and are also available in PDF format on the
installation disk.

e Agilent 6100 Series Quadrupole LC/MS Systems Familiarization Guide

Agilent 6100 Series Quadrupole LC/MS Systems Concepts Guide
Agilent 6100 Series Quadrupole LC/MS Systems Installation Guide
Agilent 6100 Series Quadrupole LC/MS Systems Maintenance Guide

What's New in B.04.02 SP1?

Support for new G6120B, G6130B, and G6150B Single Quadrupole
LC/MS systems.

Support for Agilent Jet Stream Technology on the 6150.

Support for Microsoft Windows XP Professional 32-Bit with Service
Pack 3.

Support for Microsoft Windows Vista Business 32-Bit with Service
Pack 2.

Easy Sequence, a new interface to plan, generate and queue sequences.

What's New in B.04.02?

New ChemStation Software Features

For Agilent 1100
/1200 LC
Systems users

Easy Sequence: A new easy-to-use user interface for sequence planning,
generation and queueing.

Full support for all modules in the Agilent 1200 LC series, including
the Agilent 1200 Rapid Resolution SL LC System and the new Agilent
1290 Infinity LC System, which consists of the following hardware
modules.

Agilent G4220A 1290 Binary Pump

Agilent G4226A 1290 High Performance Autosampler
Agilent G1316C 1290 Thermostatted Column Compartment
Agilent G4212A 1290 DAD

Agilent G4227A Infinity FlexCube

A new user interface for LC instrument control in the Method and Run
Control view with:
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Flexible sizing of the Instrument Control panel to make best use of
the available desktop space.

Show/hide functionality to reduce the display to the most essential
information.

Graphical representation of multiple devices of the same kind (for
example, two pumps).

Graphical representation of all valves.

Direct access to method parameters and all important functions for
each module.

Status display for the individual modules and resulting overall
instrument status.

Tooltips display most important information on specific functions.

Tabular display of the sample information for the current run or
sequence line.

Direct access to Data Analysis parameters and settings for OpenLAB
ECM (with G2189BA ChemStation OpenLAB option only).
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Configuration Diagrams

Configuration Diagrams
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Configuration Diagrams

LC Cabling
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ChemStation Views

ChemStation Views

The LC/MS Quad ChemStation software consists of several views, which
are described below. Switch to a different view by clicking one of the view
buttons in the lower left corner of the screen (shown below) or from the
View menu.

Hﬂ Method and Run Control

By ] Data Analysis
ﬁ Report Layout

% Verification (0Q/PV)

@ Diagnosis

C_%' M5D Tune

Method and Run Control View Allows you to set up methods and adjust
instrument parameters to inject samples and acquire data one sample at a
time or in automated sequences. See the next page for more information.

Data Analysis View Allows you to perform various data evaluation tasks
on chromatograms and spectra, such as integration, quantitation, checking
peak purity, deconvolution, and report generation. See page 11 for more
information.

Report Layout View Allows you to design custom report templates to use
with the data generated by your ChemStation. See page 14 for more
information.

Verification (0Q/PV) View For use by Agilent service engineers to
determine if your system is operating in a predictable manner. This is
useful to show Good Laboratory Practice (GLP) compliance and may be
required by some government agencies. See page 16 for more information.

Diagnosis View Allows you to run tests to diagnose instrument problems
and access information on how to resolve these problems. The early
maintenance feedback (EMF) feature can notify you when it is time to
perform system maintenance before a problem occurs. See page 18 for
more information.
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ChemStation Views

MSD Tune View In this view, you can calibrate your LC/MS quad
automatically. You can also set MS parameters manually for specific types
of molecules. See page 19 for more information.

Method and Run Control View

Tool Set Selection: Sequence Method Sequence Top Toolbar Status Bar
or Single Sample
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ChemStation Views

The user interface for Method and Run Control can be configured in two ways during
installation. See Agilent 6100 Series Single Quad LC/MS System Installation Guide for
information on installation and configuration.

If your instrument is configured with the Classic user interface, then see ChemStation
online Help and the following manuals on the ChemStation disk for information and
instructions using the Classic interface:

+ Agilent 6100 Series Single Quad LC/MS Systems Quick Start Guide
» Agilent 6100 Series Quadrupole LC/MS Systems Familiarization Guide
« Agilent 6100 Series Quadrupole LC/MS Systems Concepts Guide

Status and Run  Right- click the Method icon to see the following commands:
Bars: MainTab Run Time Checklist, Method Information, Edit Entire Method, Method
Audit Trail, Print Method, and Help.

and Run Control

I Automation Controls I

Ready | T | () vethod: DEFLCM | i Sequence: DEF_LCS | (EWAIF ‘

@ Sequence | ) Pause | @ Resume | @ Stop |§_|

Start Stop Method
Sequence Sequence
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ChemStation Views

System Diagram  Each icon of the system diagram represents one component or module of
your system. Click on an icon if you want to edit the method parameters
or go to the online Help for that particular component.

Injector Pump & Solvents Column Detectors
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Integration
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Reporting
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ChemStation Views

Single Sample This toolset allows you to work on methods and run an analysis for a
Tool Set  single sample. Move the cursor over a button to view a description of it.

= Click the Single Sample icon to display this toolset.

[C2 RN SN WS W

Sequence  This toolset allows you to work on sequences and run automated analyses

Tool Set of multiple samples. Move the cursor over a button to view a description
of it.

Click the Sequence icon to display this toolset.

sy

[E2IEER= AN N

Flow Injection  This toolset allows you to inject multiple samples directly into the

Analysis (FIA)  detector, bypassing the chromatographic column. The results are sent to a
single data file. FIA can be used for method development or for
applications that do not require chromatography.

 p 3 To enable FIA from the system diagram:
! |.' | *  Click the FIA icon.
+  Select Edit FIA Series.
» Mark the Enable FIA Series in Method option and edit the

FIA Table.
i ”|- Edit FIA Series
e Method
Edit FIA Series...
il Help  Enable FlA Series in Method
FIA Table
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Data Analysis View

Navigation Tools

strument 1 (online): Data Analysis

ChemStation Views
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The various tool sets available in Data Analysis View are shown on the
following pages. You can view a description of a button by moving the

cursor over it.
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ChemStation Views

Common Tool Set This toolset is always present in Data Analysis view.

= ENEYN

Graphics Tool Set Allows you to manipulate the graphic display.
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Integration Tool Set Allows you to perform integration and reporting tasks
on a chromatogram.

Rl OANA
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ChemStation Views

Calibration Tool Set Allows you to perform calibration tasks for
quantitation.

ﬁi} 5—’{%} @ ,ﬁl M | Report:  Short _5 _l ﬂ &
ﬂﬁ}l@ v Overview vE%Jh.‘&ﬁﬁ

Signal Tool Set Allows you to graphically work with the UV or MS signal.
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Purify Tool Set Allows you to graphically work with your purification data.

38 | (@] =2 4] [s]

Spectral Tool Set Allows you to perform spectral evaluation tasks.
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Deconvolution Tool Set Allows you to transforms mass spectra from
multiply- charged ions into a calculated molecular weight.
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ChemStation Views

Report Layout View

Report Template Calculation Technique

% Instrument 1 (sffline 1): Report Layeut _

New Section Menu
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L st eport Section
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sl | Method and Run Control
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Message Line R T T

Report Layout

Tool Set This toolset is present in the Report Layout view. Move the
cursor over a button to view a description of it.

ENCY MR- XOTRe

Tips < Edit or create a report layout as described in the online Help.

¢ To test your report layout, select a calculation technique from the
drop-down list box to define how the results should be calculated.

* Load a data file. The results are loaded into the report template using
the selected calculation.

¢ Select File / Add to Report Styles to add your completed report
template to the list of available report styles. Now you can use your
customized report within a method.
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ChemStation Views

Sample Report Layouts (in \CHEM32\REPSTYLE)

Template Description
SIMPLE.FRP Includes a chromatogram and calibration curves per calibrated
compounds.

NESTED.FRP Shows how to nest subsections.
SPECTRA.FRP  Shows how to include spectra.
PURITY.FRP Shows how to include peak purity data.

ESTD.FRP Uses the same elements as the standard ESTD reports so you can . .
customize your external standard reports. Print Preview button
AREAPCTFRP  Uses the same elements as the standard area percent report so you can 5
customize your area percent reports. —

LIBRARY.FRP A customized report that uses library search results. You must have a
method loaded that specifies the spectra library.

i Report IH[=] E3

Example of a simple Report Layout -
Data File name: C:\HPCHEM' 1, DATA\MEDEMOY CAFCALOZ . D g
Method name: C:WHPCHEM', 1"METHODS CAFCALIE. M

To test this template load a
calibrated method

Al Teehnal nggies Replace the logo by inserting your company logo as
) TMF graphic and insert your company name as a ™
constant text” here.

The general section comprises elements that are walid for the complete data
file. The elements below were inserted using the text and number tools.

data acequired by: mointyre
on: 176797
wvial # Z.000

DADT A, Sig=272,4 Ref=450,20 (MSDBWJOMCAF CALDZ.O)

10000
7500 -
5000
2500 -

caffeine-u

=
b4 -

I 05 1
WEDT TIC, W5 File (MSDEMTWCAF CALDZ. 0)

10000
7500
5000 - 3

-

HF Laserdet 4Si M on LPT1:
Letter 81/2 x 11 in/Portrait

Closel |n0rma| j| Page|1 j|0f2 Prew | Next | Print | Help |
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ChemStation Views

Verification (0Q/PV) View
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The Verification (OQ/PV) view lets Agilent service engineers test whether
your analytical instruments and the ChemStation software are operating
correctly according to predefined performance criteria.

Operation Qualification (0Q) Operation Qualification is the documented
verification that the equipment-related system or subsystem performs as
intended throughout representative or anticipated operating ranges.

Performance Verification (PV) Performance Verification is the documented

verification that the process and or the total process-related system
performs as intended throughout all anticipated operating ranges.
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ChemStation Views

System Diagram Each icon of the system diagram represents one
component or module of your system.

Verification Toolbar The Verification toolbar is displayed when you select
Show Top Toolbar from the View menu. Move the cursor over a button to
view a description of it.

B0 En g S T O B 0 S

Available Tests The following verification tests are supplied with your
ChemStation software for use by an Agilent service engineer. Refer to the
online Help for more information on these tests.

e VWD Wavelength Accuracy

¢ Intensity

e Holmium

¢ Temperature Accuracy

¢ Noise, Flow, Temperature

¢ DAD Wavelength Accuracy

¢ Injector Precision*

¢ Detector Linearity/Carry-over*
¢ Injector Linearity*

¢ Gradient Composition

* These tests can be used to verify LC/MS quad performance.
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ChemStation Views

Diagnosis View

Symptoms Possible Causes Cause
Information Pad

Task ® Aiolina (online): Diagnosis SCAN Cl POS_M, SIG10002.D, ATUNES_TUN
Selection
Menu
System On
Systam OFF
Instrument
Panel
s ] Method and Run Control
L]
View
Selection
Message Line Variables Display

This view allows you to carry out diagnostic and maintenance activities on
your system.

Diagnosis Toolbar The Diagnosis toolbar is displayed when you select
Show Top Toolbar from the View menu. Move the cursor over button to
view a description of it.
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MSD Tune View

MSD Tune Toolbar

Title Bar

File Selection

¥ Souce APLALS

Calboant | OFF

ChemStation Views

Status Bar

= S Standed -

View Selection

Message Line

MSD Tune Toolset

This toolset is present in MSD Tune view.
|_ Load an LC/MS quad tune file. _—,J_'l,li,l

=3

¥

Save the current tune file.

o
g

Generate a profile and scan report.

B

Autotune the LC/MS quad and
print a tune report.

EJ
i

=
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Calibrate the mass axis.
Change spray chamber
parameters.

Edit LC/MS quad parameters for
manual tuning.

Acquire multiple scans and send
results to data file.



Basic Operation

Basic Operation

Start up and Shut Down the System

Task

Instruction

Comment

To start up the system

To put the system in Standby Mode

1 From the Method and Run Control
view, click the , button on the
system status bar. When you move
mouse over the button, it turns green if
system is currently idle.

2 Set up the LC conditions (pump,
column heater, and detector).

3 Setupthe LC/MS quad spray chamber
conditions as described in the MSD
Spray Chamber dialog box topic in the
online Help.

Allow 15 minutes for the system to warm

up.

1 Flush the system with pure mobile
phase to ensure the flow path is clear
of buffers. This avoids plugging the
nebulizer. A plugged nebulizer can
cause a high back pressure, which can
damage the LC flow cell.

It is good practice to flush the flow
path (including the column) for 5-10
minutes with a mobile phase without
buffers such as 50:50
water/acetonitrile.

2 Clickthe ) button on the system
status bar. All modules are set to
standby mode (indicated by the gray
color in the system diagram).

This procedure assumes the system is
under vacuum and the LC and LC/MS
quad are properly connected. It also
assumes the liquid flow path is
properly set up.

Put the system in standby mode
overnight or whenever you won't be
analyzing samples for an extended
time. The standby state for the LC/MS
quad leaves the nebulizer and drying
gas on at low flow.

Standby for the LC/MS quad is:

+ 20 psi for the nebulizer,

+ 3 L/min for drying gas,

+ 300°C for drying gas temperature,

+ 325°C for the APCl vaporizer, if
present, and

* the MS stream selection valve is set
LC to Waste.

20
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Basic Operation

Tune the LC/MS quad

When the LC/MS quad is used as a detector for the LC, a mass spectrum
is associated with each data point in the LC chromatogram. To obtain
high quality, accurate mass spectra, the LC/MS quad must be optimized to:

e Maximize sensitivity
e Maintain acceptable resolution

* Ensure accurate mass assignment

Tuning is the process of adjusting LC/MS quad parameters to achieve
these goals. After the LC/MS quad parameters have been optimized, they
must be saved in a tune file (.tun). This tune file is then specified in the
method that is used to acquire data for your samples.

Frequent tuning, automated or manual, is not required. Once tuned, the
LC/MS quad is very stable. Tuning should generally be needed no more
often than monthly, weekly at most.

Wait 712 hours after pumpdown before tuning or operating your LC/MS
quad. The analyzer takes about 12 hours to reach thermal equilibrium.
Tune files that are created or data that is acquired before the LC/MS quad
is at thermal equilibrium may have incorrect mass assignments and other
inaccuracies.

Task Instructions Comments

To use Autotune 1 From the MSD Tune view, select Use autotune for automated
Autotune from the Tune menu or click  adjustment of the LC/MS quad
the Autotune toolbar button. performance.

2 Review the tune report that is printed
automatically when tuning is
completed.
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Basic Operation

Task Instructions Comments
To use Check Tune 1 Select Check Tune from the Tune Use Check Tune to quickly determine
menu. whether the LC/MS quad is correctly
2 Review the Check Tune report. tuned. It performs a single profile scan
Adjustments are suggested for values  of the tune masses and compares the
that are outside of acceptable ranges.  peak widths and mass axes with target
values.
To use Manual Tune 1 Select Manual Tune from the Tune Use Manual Tune when you want to:
menu. . . + Achieve maximum sensitivity by
2 Set the desired mass resolution sacrificing some resolution
(adjusting width gain and width * Tune specifically for the very low
offs_et). . o end (<150 amu) of the mass range
3 Calibrate the mass axis (adjusting - Tune with a compound other than
mass gain and mass offset). the standard calibrants
4 Optimize the ion transmission through
the source ion optics (fragmentor,
skimmer(s), lens 1, lens 2, octopole
peak and octopole knee).
5 Adjust the signal strength (setting iris

and adjusting the multiplier gain).

Note that fragmentor and gain are
method parameters. The fragmentor
affects ion transmission and
fragmentation. For more information, see
the online Help.

22
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Basic Operation

Acquire LC/MS Data

Modes of Acquisition

There are three modes of acquiring data:
¢ Running a method for a single sample
* Running a sequence for multiple samples

¢ Running an FIA series

Note the following about acquiring data:

All three acquisition modes require an appropriate method.

Samples may be injected either manually or with an ALS.

¢ A run must always be started from the software.

An FIA method cannot be used in a sequence but multiple FIA methods
can be run sequentially.
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Basic Operation

To edit a method and start a run

Once you know the acquisition mode you want to use, you need to set up

24

an appropriate method. Methods are set up in the Method and Run
Control view.

Instructions

Comments

1

Activate the single sample toolset by clicking the
[] button on the toolbar.

Load a method by selecting Method / Load Method or
by clicking the [y button on the toolbar and selecting
a method from the list.

Clickthe f button to begin editing the method. You
can also begin by selecting Edit Entire Method from
the Method menu or by right-clicking the m icon
on the Run Control Bar.

Select the method sections you want to edit (select all
sections to become familiar with the method
parameters that are available) and click OK.

Add any method comments you want to appear on
your reports.

Set up the instrument parameters, such as pump,
injector, DAD or VWD, column thermostat, MS quad
signals, and MS quad spray chamber.

Set up the Data Analysis parameters, such as signal
details, integration events, report parameters,
instrument curves, calibration curves, calibration
table, and ion parameters.

Complete the Run Time Checklist.

Save the method using a different name. Select
Method / Save Method As or click the [}, button on
the toolbar.

10 When you are ready to begin a run, click the Start

button.

A series of dialog boxes is displayed,
which allows you to set up your
method and instrument parameters.

Click the Help button on any of the
method dialog boxes for descriptive
information on the items available in
each.

Once you are familiar with the options
that are available, you can use the
system diagram menus for quick
access to particular method
parameters, rather than using the edit
entire method process.
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Basic Operation

Use Deconvolution (optional - requires additional license)

Deconvolution is a process that transforms mass spectra from
multiply- charged ions into a calculated molecular weight.

To deconvolute a mass spectrum

Instructions

Comments

1

In the Data Analysis view, load an electrospray MS

data file. The TIC is displayed.

Generate the MS spectrum that you want to

deconvolute (select the Spectral task tool set and use
the spectrum selection tools to pick the spectrum of

interest).

Click the Enter Deconvelution Tool button to

set up the deconvolution display area.

When the spectrum is displayed, click the
Label lons button to locate masses to be

used in deconvolution.

Ak

=ln

Examine the ions that were found. Very noisy data or
data with unresolved regions often need special

settings to find ions.

Click the Edit Deconvolution Parameters
button to change any of the parameters.

Click the Run Deconvelution button to begin

the deconvolution process.

A

A

Select specific components from the Component list to

look at individual components or groups of

components.

Optionally, select components from the
Component List box and then click the
Delete Components button.

10 Repeat the process.

n

Note that these operations are
performed on data acquired in full scan
mode.

You can use the lon Label
Options button to optimize
the set of ions found.

iif]

Once the deconvolution is done, the
components are displayed in the upper
right window. The charge states are
displayed in the lower right window.

Optionally, click the Preview
Deconvolution Report
button

or click the Print Report
button.

&

This action removes the peaks for the
selected components from the original
spectrum. You can then continue with
step 4 above, using this new spectrum.

Agilent 6100 Series Quad LC/MS System Quick Start Guide
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Basic Operation

Deconvolution Report

The Deconvolution report contains summary information about each
component selected, along with detailed information on how each peak in
a component contributes to the component's molecular weight. In the first
part of the report, the components are ranked by percent relative
abundance, which is useful for estimating the percent of impurities.

Note that the actual molecular weight may differ from the computed
molecular weight even if the data fit a Gaussian curve perfectly, due to
other errors such as errors in mass axis assignment or unresolved
chemical impurities.

The Deconvolution software is optional and is part of the G2720BA
Bioanalysis Software package.
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Operating Tips

Operating Tips

Back up your data and methods regularly to avoid loss of data if the
files are accidentally overwritten, deleted, or if a hardware problem
develops with your disk drive.

Put the system in standby mode overnight or whenever you won’t be
analyzing samples for an extended time.

Verify that the tune file you are using is appropriate for your samples.
Save Tune reports in an MS Logbook for future reference.

Regular system maintenance can reduce problems. Keep a maintenance
record.

Use the Maintenance Logbook and EMF features in Diagnosis view to
help you keep track of when maintenance is needed and to keep an
online maintenance record.

Flush the sample path and clean the spray chamber, capillary tip, and
spray shield daily or at the end of each shift. Check the foreline pump
fluid level every week.

The spray chamber vent hose must be connected to a lab vent that is
used only for the source (completely separate from the vent hose for
the foreline pump). Otherwise, waste products can migrate into the
spray chamber vent producing chemical noise.

Samples need to be filtered. They should be salt and detergent-free if
no chromatography is used.

If a UV detector is available, use it in series with the LC/MS quad. Try
to minimize chromatographic peak broadening by using low dispersion
tubing.

To avoid chromatographic band broadening, be sure that all tubing
connections are free of dead volume. Use zero dead-volume (ZDV)
fittings when possible.

Use finger-tight fittings on the LC inlet union. Swaged fittings can
compress the frit.

If you are using APCI, the optimal flow rate is 1.0 ml/min. The range is
0.5 to 1.5 ml/min.
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¢ Use the following table as a guide to using SIM, condensed scan, and
full scan acquisition modes.

Task Mode

Acquire electrospray data for samples containing large, Full Scan
multiply-charged analytes.

Analyze a mixture with unknown components (small molecules). Scan

Analyze a mixture with known components in unknown amounts Scan or SIM
(quantitate).

Identify the presence of a few known compounds at low levels within ~ SIM

a mixture.

Use fast chromatography on SL MS quads without missing peaks. Fast Scan

Use fast chromatography on 6150B AJS-HT MS quads without Ultra Fast Scan

missing peaks.
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Troubleshooting Tips

No peaks

v/ Verify that there is spray from the nebulizer.

v/ Verify that the capillary voltage is set correctly.

v’ Verify that the MS system is tuned correctly.

v’ Verify that MS vacuum pressures are within normal ranges.

¢’ Check the drying gas flow and temperature.

v Verify that the fragmentor is set correctly.

v Check if any error message indicates a problem with electronics.

v/ Verify that sufficient sample is present in vial.

Poor mass accuracy

v/ Recalibrate the mass axis.

v/ Verify that the ions used for tuning span the mass range of the sample
ions and that they show strong, stable signals.

Low signal

¢’ Check the solution chemistry. Verify that the solvent you're using is
appropriate for your sample. Mixed samples can exhibit signal
suppression of one or more components.

v’ Verify that the sample is fresh and has been stored correctly.
v/ Verify that the MS system is tuned correctly.

v’ Check the nebulizer condition.

v/ Clean the capillary entrance.

v/ Check the capillary for damage and contamination.

v’ Verify that the spray chamber parameters are set correctly, such as
drying gas heater and nebulizer pressure.
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Unstable signal

v’ Verify that the drying gas flow and temperature are correct for the
solvent flow you are using.

v/ Verify that the solvent is thoroughly degassed. Do not use ultrasonic
degassing with protein samples.

v Verify that the LC backpressure is steady; this indicates a steady
solvent flow.

High spectral noise

v Use appropriate mass filter values.

v’ Check the spray shape. Nebulizer may be damaged or incorrectly set.

v Verify that drying gas flow and temperature are correct for the solvent
flow you are using.

v/ Verify that the solvent is thoroughly degassed. Do not use ultrasonic
degassing with protein samples.

v Verify that the LC backpressure is steady; this indicates a steady
solvent flow.

v If you are using water as part of the mobile phase, verify that it is
de-ionized (>18MQ).
Droplets, not spray, exiting the nebulizer

v/ Verify that the nebulizing gas pressure is set high enough for the LC
flow being used.

v/ Check the position of the needle in the nebulizer.

v Stop the solvent flow and remove the nebulizer assembly. Use a
magnifying glass to examine the end of the nebulizer for damage.
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No flow

v’ Verify that the LC is on and there is sufficient solvent in the correct
bottle.

v Check for LC error messages.
v Check for blockages. Repair or replace any blocked components.
v’ Check for leaks.

v/ Verify that the MS stream selector valve is set to LC to MSD.

Undesired fragmentation
v Fragmentor is set too high.
v Ionization is causing fragmentation (APCI vs. Electrospray).

v/ APCI temperature is too high.
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Safety Warnings

Intended Purpose

Use of the LC/MS quad in a manner not intended by the manufacturer is
prohibited.

Safety Class

The LC/MS quad is a Safety Class 1 instrument and has been designed
and tested in accordance with IEC Publication 1010-1, Safety
Requirements for Electrical Equipment for Measurement, Control, and
Laboratory Use.

Stack Configuration

m Do not stack more than three LC modules of any kind on top of the LC/MS$S
instrument. Stacking more than three LC modules is potentially unstable and
dangerous.

Placing the LC modules on top of the LC/MS quad is also inconvenient. It
puts the solvent bottles and some LC controls out of easy reach and
requires the LC stack to be disassembled and removed for LC/MS quad
maintenance.

m Use only Nitrogen as the drying and nebulizer gas. Air, oxygen, or other gases, when
combined with solvents and high voltages in the spray chamber, can resultin an
explosion.

m Do not connect the LC/MS quad to a power source that is not equipped with a
protective earth contact. You can create a shock hazard for the operator and can

damage the instrument.

m Do not interrupt the protective conductor inside or outside the LC/MS quad or
disconnect the protective earth terminal. You can create a shock hazard for the
operator and can damage the instrument.
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m Do not adjust, maintain, or repair the opened instrument while it is connected to a
power source. These operations should be performed only by trained persons who
are aware of the hazards involved.

m Before you perform maintenance on the electronics or turbo controllers, turn off the
main circuit breaker and disconnect the power cord. The power switch on the front
of the LC/MS quad does not completely cut power to the instrument.
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